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Chapter  1—General  Information
This chapter provides general information about READ NATURALLY SE's
requirements and installation options.  This chapter includes the following topics:

System Requirements

Installation Types

Contacting READ NATURALLY
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System Requirements
To use the READ NATURALLY SE applications, you must meet the following
minimum hardware and software requirements.

Windows

Windows 95 or higher

200 MHz or faster

32 MB RAM

10 MB hard disk space

CD-ROM drive

800 x 600 screen resolution 

Internet Explorer 5.0 or higher
(included on the Installation CD)

Macintosh

System 9 or higher

200 MHz or faster

64 MB RAM

15 MB hard disk space

CD-ROM drive

800 x 600 screen resolution

Internet Explorer 5.0 or higher
(included on the Installation CD)
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Installation Types
READ NATURALLY SE offers two different installation types.

Installation Type Description

Stand-Alone The stand-alone or local installation program
installs the READ NATURALLY SE applications on a
single computer.  With this installation, teachers
and students open the applications from the
computer's hard drive, run the stories from the
CD drive (using a separate CD for each level),
and update a set of data files on the hard drive.

Network The network installation program installs some of
the READ NATURALLY SE applications on a server
and some of the READ NATURALLY SE
applications on client workstations.  With this
installation, teachers and students open the
applications from their individual workstations,
run the stories from either the workstation's CD
drive or a network drive, and update a set of data
files on a network drive on the server.
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Contacting READ NATURALLY

Telephone 651-452-4085
800-788-4085

Fax 651-452-9204

Email info@readnaturally.com — For general questions.
support@readnaturally.com — For technical assistance.

You can contact READ NATURALLY using the information below.

Web www.readnaturally.com

Office Hours Monday through Friday
9:00 A.M. to 5:00 P.M. Central Standard Time
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This chapter provides information about installing the Windows stand-alone version
of the READ NATURALLY SE applications.  The stand-alone version installs the
applications on a single computer.  This chapter includes the following topics:

What's Installed

Installing the Windows Stand-Alone Version

Uninstalling the Windows Stand-Alone Version

What's Installed
The Windows stand-alone installation program installs the files and folders listed
below (along with some additional files and folders used by the READ NATURALLY
SE applications).

Files/Folders Installed Description

RNStudentStories.exe

RNMgmt.exe

Data

RNHelp

Reports

Xtras

Lists

The Student Stories application

The Teacher Management System application

A folder containing data files

A folder containing help files

A folder containing report files

A folder containing files necessary to run programs

A folder containing lists of the stories in each level

Chapter  2—Windows  Stand-AAlone  Installation
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Installing the Windows Stand-Alone Version
The Windows stand-alone installation process includes the following tasks:

Licensing READ NATURALLY SE 

Installing READ NATURALLY SE 

Adding Additional Levels

Getting Started in the Teacher Management System

Task 1: Licensing READ NATURALLY SE

Before you begin, you should close all other applications.

1 Insert the installation CD into the computer's CD-ROM drive.  The installation
program begins automatically.  If the installation program doesn't begin
automatically, go to the CD drive and double-click the Install.exe program.

2 Read the information on the Welcome window, and then click the Next button.

3 Enter your license number on the License
Number window.  If you have multiple license
numbers, enter one of the license numbers (you
will enter the others in task 4).  Press the Tab
key after entering each portion of the license
number, and then click the Next button.

Note: If a message displays telling you your
license number is invalid, contact READ
NATURALLY.
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Installing the Windows Stand-Alone Version, continued

Task 2: Installing READ NATURALLY SE

The READ NATURALLY SE installation program begins automatically after entering
the licensing information.

1 Read the information on the Welcome window, and then click the Next button.

2 Read the license agreement information, and then click the I Agree button.

3 Indicate the location where you want to install
the READ NATURALLY SE applications, and then
click the Next button. The default location is
C:\Program Files.  You can accept the default
location or browse to a different location.  To
browse to different location, click the ellipse
(...) button.  You do not need to create a folder.
The installation program automatically creates
a folder called READ NATURALLY.

4 Confirm the location where you want to install
the applications, and then click the Start button
to begin the installation process.

5 Click the Exit button to continue with the installation process.

Result: The installation program creates a READ NATURALLY folder in the location
you specified on the hard drive and a Student Stories shortcut for the
desktop.  A status bar shows the installation progress, and a message
displays when the process completes.



Task 3: Adding Additional Levels

After you complete the READ NATURALLY SE installation, you can enter additional
license numbers to authorize additional levels.  Follow the steps below to add
additional levels and/or continue to task 4.

1 If you want to add another level, click the Next button.  If you do not want to
add another level, go to step 4.

2 Enter the next license number (pressing the Tab
key after each portion), and then click the Next
button.

3 If you want to add another level, click the Next button and go to step 2.  If you
do not want to add another level, go to step 4.

4 Click the Exit button to finish adding levels.

Windows Stand-Alone Installation 8 Copyright© 2002 READ NATURALLY
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Installing the Windows Stand-Alone Version, continued

Result: A message displays indicating the level
was added successfully.



Installing the Windows Stand-Alone Version, continued

Task 4: Getting Started in the Teacher Management System

After you complete the READ NATURALLY SE installation, a message displays letting
you know that you must enter teacher, class, and student information in the Teacher
Management System before students can begin using the READ NATURALLY Student
Stories program.  If you want to open the Teacher Management System
immediately, click the Yes button.  The blue Teacher Management System will open.
Then follow the directions on page 25 of the User Guide to get started in the
Teacher Management System.

If you do not want to open the Teacher Management System now, click the No
button.  You can open the Teacher Management System later by following the
directions on page 24 of the User Guide.

Copyright© 2002 READ NATURALLY 9 Windows Stand-Alone Installation
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Uninstalling the Windows Stand-Alone Version
To remove the READ NATURALLY SE applications from your computer, you need to
complete the following tasks:

Run the Uninstallation Program

Delete the READ NATURALLY Folder (necessary if you have entered information
in the Teacher Management System)

Task 1: Run the Uninstallation Program

1 Select Start > Programs > READ NATURALLY > Uninstall READ NATURALLY.

2 Click the OK button to confirm you want to uninstall the READ NATURALLY files
from your hard drive.

3 Click the OK button when reminded to delete the READ NATURALLY folder from
your hard drive.

Task 2: Delete the READ NATURALLY Folder

To delete the READ NATURALLY folder, complete the following steps:

1 Locate the READ NATURALLY folder on the hard drive, and then select it.

2 Select Delete from the File menu.

Tip: You can also uninstall READ NATURALLY SE by selecting Start > Settings >
Control Panel > Add/Remove Programs and then selecting READ
NATURALLY from the list of installed programs.

Windows Stand-Alone Installation 10 Copyright© 2002 READ NATURALLY
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Chapter  3—Macintosh  Stand-AAlone  Installation
This chapter provides information about installing the Macintosh stand-alone
version of the READ NATURALLY SE applications.  The stand-alone version installs
the applications on a single computer.  This chapter includes the following topics:

What's Installed

Installing the Macintosh Stand-Alone Version

Uninstalling the Macintosh Stand-Alone Version
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What's Installed
The Macintosh stand-alone installation program installs the files and folders listed
below (along with some additional files and folders used by the READ NATURALLY
SE applications).

Files/Folders Installed Description

Student Stories

Teacher Management

Data

RNHelp

Reports

Xtras

Lists

The Student Stories application

The Teacher Management System application

A folder containing data files

A folder containing help files

A folder containing report files

A folder containing files necessary to run programs

A folder containing lists of the stories in each level

Macintosh Stand-Alone Installation 12 Copyright© 2002 READ NATURALLY
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Installing the Macintosh Stand-Alone Version
The Macintosh stand-alone installation process includes the following tasks:

Licensing READ NATURALLY SE 

Installing READ NATURALLY SE 

Adding Additional Levels

Getting Started in the Teacher Management System

Task 1: Licensing READ NATURALLY SE

Before you begin, you should close all other applications.

1 Insert the installation CD into the computer's CD-ROM drive.

2 If the CD window does not open automatically, double-click the CD icon on the
desktop to open the program.

3 Double-click the Install icon.

4 Read the information on the Welcome
window, and then click the Next button.

5 Enter your license number on the License
Number window.  If you have multiple
license numbers, enter one of the license
numbers (you will enter the others in task 3).
Press the Tab key after entering each portion
of the license number, and then click the
Next button.

Copyright© 2002 READ NATURALLY 13 Macintosh Stand-Alone Installation
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Note: If a message displays telling you your license
number is invalid, contact READ NATURALLY.



Installing the Macintosh Stand-Alone Version, continued

Task 2: Installing READ NATURALLY SE

The READ NATURALLY SE installation program begins automatically after entering
the licensing information.

1 Read the information on the Welcome window, and then click the Continue
button.

2 Read the information on the READ NATURALLY Software Edition License
Agreement window, and then click the Agree button.

3 Click the Install button.

4 Indicate the location where you want to install the
READ NATURALLY SE applications, and then click 
the Choose button to begin the installation process.
The default location is the computer's hard drive
(e.g., if the hard drive name is "Macintosh HD," the
default is "Macintosh HD").  You can accept the
default location by clicking the Choose button or
you can select a different location.  You do not
need to create a folder.  The installation program
automatically creates a folder called READ
NATURALLY.

Result: The installation program creates a READ NATURALLY folder in the location
you specified on the hard drive and a Student Stories alias for the desktop.
A status bar shows the installation progress, and a message displays when
the process completes.

Macintosh Stand-Alone Installation 14 Copyright© 2002 READ NATURALLY
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Installing the Macintosh Stand-Alone Version, continued

Task 3: Adding Additional Levels

After you complete the READ NATURALLY SE installation, you can enter additional
license numbers to authorize additional levels.  Follow the steps below to add
additional levels and/or continue to task 4.

1 If you want to add another level, click the Next button.  If you do not want to
add another level, go to step 4.

2 Enter the next license number (pressing the Tab
key after each portion), and then click the Next
button.

3 If you want to add another level, click the Next button and go to step 2.  If you
do not want to add another level, go to step 4.

4 Click the Exit button to finish adding levels.

Result: A message displays indicating the
level was added successfully.
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SE Installation Guide



Installing the Macintosh Stand-Alone Version, continued

Task 4: Getting Started in the Teacher Management System

After you complete the READ NATURALLY SE installation, a message displays letting
you know that you must enter teacher, class, and student information in the Teacher
Management System before students can begin using the READ NATURALLY Student
Stories program.  If you want to open the Teacher Management System
immediately, click the Yes button.  The blue Teacher Management System will open.
Then follow the directions on page 25 of the User Guide to get started in the
Teacher Management System.

If you do not want to open the Teacher Management System now, click the No
button.  You can open the Teacher Management System later by following the
directions on page 24 of the User Guide.
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To remove the READ NATURALLY SE applications from your computer, you need to
complete the following tasks:

1 Insert the installation CD into the computer's CD-ROM drive.

2 Double-click the Uninstall Read Naturally SE icon.

3 Select the Uninstall option from the drop-down
menu, and then click the Uninstall button.

Uninstalling the Macintosh Stand-Alone Version

Copyright© 2002 READ NATURALLY 17 Macintosh Stand-Alone Installation
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Result: The uninstall program removes all of
the READ NATURALLY SE files from
your hard drive.



This chapter provides information about installing the Windows network version of
the READ NATURALLY SE applications.  The network version installs some of the
applications on a server and some of the applications on client workstations.  This
chapter includes the following topics:

What's Installed

Installing the Windows Network Version

Uninstalling the Windows Network Version

Chapter  4—Windows  Network  Installation
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What's Installed
The Windows network installation program installs the files and folders listed below
on the server (along with some additional files and folders used by the READ
NATURALLY SE applications).

Files/Folders Installed Description

InstallWkstnWin.exe

RNReset.exe

FileCopy.exe

Data

ReadNaturallyCD

The workstation installation program

A utility that resets user information

An application that copies the stories to the server

A folder containing data files

A folder containing stories for each level licensed

The Windows network installation program installs the files and folders listed below
on each client workstation (along with some additional files and folders used by the
READ NATURALLY SE applications).

Files/Folders Installed Description

RNStudentStories.exe

RNMgmt.exe

RNHelp

Reports

The Student Stories application

The Teacher Management System application

A folder containing help files

A folder containing report files
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Installing the Windows Network Version
The Windows network installation process includes the following tasks:

Setting Up Access Privileges

Licensing READ NATURALLY SE

Installing the READ NATURALLY SE Server

Adding Additional Levels

Copying Stories to the Server

Installing READ NATURALLY SE at Workstations

Getting Started in the Teacher Management System

Task 1: Setting Up Access Privileges

Prior to running the READ NATURALLY installation program, you or someone with
full access privileges to the server (e.g., the network administrator) must create a
shared folder on the server.  You need to install the READ NATURALLY applications to
this shared folder.  You should name the folder something other than "READ
NATURALLY" (e.g., "Reading Class" or "Reading") because the installation program
automatically creates a subfolder called READ NATURALLY.

All teachers and students who will use the READ NATURALLY applications need
read/write access privileges to the shared folder on the server.  You may want to set
up a user group or a logon account for each teacher and student that provides the
correct access to the READ NATURALLY information on the server.
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Installing the Windows Network Version, continued

Task 2:  Licensing READ NATURALLY SE

Before you begin, you should close all other applications.  To complete both the
READ NATURALLY SE Licensing and the READ NATURALLY SE Server Installation
tasks, you must logon to the network as the network administrator from a client
workstation (i.e. you must have full access privileges to the server).

1 Logon to the network from a client workstation as the network administrator.

2 Insert the installation CD into the CD-ROM drive.  The installation program
begins automatically.  If the installation program doesn't begin automatically, go
to the CD drive and double-click the Install.exe program.

3 Read the information on the Welcome window, and then click the Next button.

4 Enter your license number on the License
Number window.  If you have multiple
license numbers, enter one of the license
numbers (you will enter the others in task
4).  Press the Tab key after entering each
portion of the license number, and then
click the Next button.

Note: If a message displays telling you
your license number is invalid,
contact READ NATURALLY.
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Installing the Windows Network Version, continued

Task 3: Installing the READ NATURALLY SE Server
The READ NATURALLY SE server installation program begins automatically after you
enter your licensing information.

1 Read the information on the Welcome window, and then click the Next button.

2 Read the license agreement information, and then click the I Agree button.

3 Indicate the location on the server where you want to
install the READ NATURALLY SE applications.  You
should browse to the shared folder you created when
setting up access privileges (task 1).  To browse to the
folder, click the ellipse (...) button.  When you find the
correct folder, click the OK button.  Then click the
Next button.

4 Confirm the location to install the programs, and then click the Start button to
begin the installation process.

5 Click the Exit button to continue with the installation process.

Result: The installation program automatically creates a subfolder in the shared
folder called READ NATURALLY.

Result: The installation program copies the READ NATURALLY files to the location
you specified on the server's hard drive.  A status bar shows the installation
progress, and a message displays when the process completes.

Result: A message displays indicating that the first level was added successfully.
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Installing the Windows Network Version, continued

Task 4: Adding Additional Levels

After you complete the READ NATURALLY SE server installation, you can enter
additional license numbers to authorize additional levels.  Follow the steps below to
add additional levels and/or continue to task 5.

1 If you want to add another level, click the Next
button.  If you do not want to add another level,
go to step 4.

2 Enter the next license number (pressing the Tab
key after each portion), and then click the Next
button.

3 If you want to add another level, click the Next button and go to step 2.  If you
do not want to add another level, go to step 4.

4 Click the Exit button to finish adding levels.

Result: A message displays indicating the level
was added successfully.

Result: A window displays asking whether you want to copy the stories from the
disks to the server.



Installing the Windows Network Version, continued

Task 5: Copying Stories to the Server

With a network installation, you can copy the READ NATURALLY stories to the server.
If you copy the stories to the server, students do not need to use the individual CDs
for each level when they run the Student Stories application.  Each READ
NATURALLY level requires approximately 250 MB of drive space.  If you copy all the
READ NATURALLY levels to the server it requires approximately 4 GB of drive space.

1 If you want to copy the stories to the server now, click the Yes button and go to
step 2.  If you do not want to copy the stories to the server now, click the No
button and go to task 6.

2 Insert the CD for the level you want to copy in the CD-ROM drive of a client
workstation.  Then click the Continue button.

3 Click the Yes button to continue.
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Note: You should only run the stories from the server if your server has the
appropriate drive space available and you have a relatively fast network.
Otherwise, you should run the stories from the individual CDs at the
workstations.  Once you copy the stories to the server, students cannot use
the CDs to run the stories unless you reinstall the program.

Result: A message displays, verifying the level you are copying (from the CD) and
the location to which the level will be copied (the READ NATURALLY
program folder on the server).
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Installing the Windows Network Version, continued

4 If you want to copy another level, click the Yes button and go to step 2.  If you
do not want to add another level, go to step 5.

5 Click the No button to indicate you do not want to copy another level.

Task 6: Installing READ NATURALLY SE at Workstations

You must run the workstation installation program at each workstation where
teachers or students will use the READ NATURALLY SE applications.  To complete the
workstation installation, you need access to the folder you created on the server
when setting up access privileges (task 1).

1 Logon to the network from the client workstation as a user who can access the
RN Server folder on the server.

2 Connect the client workstation to the shared folder you created on the server by
selecting Map Network Drive from the Tools menu in the Explorer, selecting the
same drive letter to which you installed the READ NATURALLY applications, and
enter the path to the folder you created on the server (e.g. \\server\Reading
Class) in the Path field (or Folder field in Windows XP).

3 Double-click the InstallWkstnWin.exe program in the RN Server folder on the
server.

Result: The program copies the stories to the server.  A status bar shows the copy
progress, and a message indicating that the level was added successfully
displays when the process completes.  The copy process for a single level
takes approximately five to ten minutes (depending on the type of server
and the drive space available).



Installing the Windows Network Version, continued

4 Read the welcome information, and then click the Next button.

5 Read the license agreement information, and then click the I Agree button.

6 Indicate the location where you want to
install the READ NATURALLY SE applications.
The default location is C:\Program Files.  You
can accept the default location or browse to a
different location.  To browse to a different
location, click the ellipse (...) button.  When
you find the correct location, click the Next
button.  You do not need to create a folder.
The installation program automatically
creates a folder called READ NATURALLY.

7 Confirm the location where you want to
install the programs, and then click the Start
button to begin the installation process.

8 Click the Exit button to complete the READ NATURALLY workstation installation.
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Result: The installation program copies the READ NATURALLY files to the location
you specified on the workstation's hard drive and creates a Student Stories
shortcut for the desktop.  A status bar shows the installation progress, and a
message displays when the process completes.



Installing the Windows Network Version, continued

Task 7: Getting Started in the Teacher Management System

After you complete the READ NATURALLY SE installation, a message displays letting
you know that you must enter teacher, class, and student information in the Teacher
Management System before students can begin using the READ NATURALLY Student
Stories program.  If you want to open the Teacher Management System
immediately, click the Yes button.  The blue Teacher Management System will open.
Then follow the directions on page 25 of the User Guide to get started in the
Teacher Management System.
If you do not want to open the Teacher Management System now, click the No
button.  You can open the Teacher Management System later by following the
directions on page 24 of the User Guide.
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Uninstalling the Windows Network Version
To remove the READ NATURALLY SE applications from your system, you need to
complete the following tasks:

Run the Uninstallation Program at Each Workstation

Delete the READ NATURALLY Folder From the Server

Task 1: Run the Uninstallation Program at Each Workstation

1 Select Start > Programs > READ NATURALLY > Uninstall READ NATURALLY.

2 Click OK to confirm you want to uninstall the READ NATURALLY files.

Task 2: Delete the READ NATURALLY Folder From the Server

To delete the READ NATURALLY folder from the server, complete the following steps:

1 Locate the RN Server folder on the server, and then select it.

2 Select Delete from the File menu.

3 Click the Yes button to confirm you want to delete the folder and its contents.

Tip: You can also uninstall READ NATURALLY SE by selecting Start > Settings >
Control Panel > Add/Remove Programs and then selecting READ
NATURALLY from the list of installed programs.
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Chapter  5—Macintosh  Network  Installation
This chapter provides information about installing the Macintosh network version of
the READ NATURALLY SE applications.  The network version installs some of the
applications on a server and some of the applications on client workstations.  This
chapter includes the following topics:

What's Installed

Installing the Macintosh Network Version

Uninstalling the Macintosh Network Version
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Files/Folders Installed

InstallWkstnMac

RNReset

FileCopy

Data

ReadNatCD

Files/Folders Installed

Student Stories

Teacher Management

SetProgPath

RNHelp

Reports

What's Installed
The Macintosh network installation program installs the files and folders listed
below on the server (along with some additional files and folders used by the READ
NATURALLY SE applications).

Description

The workstation installation program

A utility that resets user information

An application that copies the stories to the server

A folder containing data files

A folder containing stories for each level licensed

The Macintosh network installation program installs the files and folders listed
below on each client workstation (along with some additional files and folders used
by the READ NATURALLY SE applications).

Description

The Student Stories application

The Teacher Management System application

A utility that sets each workstation's path to the server

A folder containing help files

A folder containing report files
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Installing the Macintosh Network Version

The Macintosh network installation process includes the following tasks:

Setting Up Access Privileges

Licensing READ NATURALLY SE

Installing the READ NATURALLY SE Server

Adding Additional Levels

Copying Stories to the Server

Installing READ NATURALLY SE at Workstations

Setting Each Workstation's Path

Getting Started in the Teacher Management System

Task 1: Setting Up Access Privileges

Prior to running the READ NATURALLY installation program, you or someone with
full access privileges to the server (e.g., the network administrator) must create a
shared folder on the server.  You need to install the READ NATURALLY applications to
this shared folder.  You should name the folder something other than "READ
NATURALLY" (e.g., "Reading Class" or "Reading") because the installation program
automatically creates a subfolder called READ NATURALLY.

All teachers and students who will use the READ NATURALLY applications need
read/write access privileges to the shared folder on the server.  You may want to set
up a user group or a logon account for each teacher and student that provides the
correct access to the READ NATURALLY information on the server.
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Installing the Macintosh Network Version, continued

Task 2: Licensing READ NATURALLY SE

Before you begin, you should close all other applications.  To complete both the
READ NATURALLY SE Licensing and the READ NATURALLY SE Server Installation
tasks, you must logon to the network as the network administrator and have full
access privileges to the server.

1 Logon to the network from a client workstation as the network administrator.

2 Insert the installation CD into the CD-ROM drive.

3 If the CD window does not open automatically, double-click the CD icon on the
desktop to open the CD.

4 Double-click the Install icon.

5 Read the information on the Welcome window, and then click the Next button.

6 Enter your license number on the License
Number window.  If you have multiple license
numbers, enter one of the license numbers (you
will enter the others in task 4).  Press the Tab
key after entering each portion of the license
number, and then click the Next button.

Note: If a message displays telling you your
license number is invalid, contact
READ NATURALLY.
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Installing the Macintosh Network Version, continued

Task 3:  Installing the READ NATURALLY SE Server

The READ NATURALLY SE server installation program begins automatically after you
enter your licensing information.

1 Read the information on the READ NATURALLY Software Edition License
Agreement window, and then click the Agree button.

2 Verify that READ NATURALLY Server option is selected, and then click the Install
button.

3 Indicate the location on the server where you want
to install the READ NATURALLY SE applications.
You should select the shared folder you created
when setting up access privileges (task 1).  Then
click the Choose button to begin the installation
process.

Result: The installation program copies the READ NATURALLY files to the location
you specified on the server's hard drive.  A status bar shows the installation
progress, and a message displays when the process completes.



Task 4: Adding Additional Levels

After you complete the READ NATURALLY SE server installation, you can enter
additional license numbers to authorize additional levels.  Follow the steps below to
add additional levels and/or continue to task 5.

1 If you want to add another level, click the
Next button.  If you do not want to add
another level, go to step 4.

2 Enter the next license number (pressing the
Tab key after each portion), and then click the
Next button.

3 If you want to add another level, click the Next button and go to step 2.  If you
do not want to add another level, go to step 4.

4 Click the Exit button to finish adding levels.
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Installing the Macintosh Network Version, continued

Result: A message displays indicating the level
was added successfully.

Result: A message displays asking whether you want to copy the stories from the
disks to the server.
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Task 5: Copying Stories to the Server

With a network installation, you can copy the READ NATURALLY stories to the server.
If you copy the stories to the server, students do not need to use the individual CDs
for each level when they run the Student Stories application.  Each READ
NATURALLY level requires approximately 250 MB of drive space.  If you copy all the
READ NATURALLY levels to the server it requires approximately 4 GB of drive space.

1 If you want to copy the stories to the server now, click the Yes button and go to
step 2.  If you do not want to copy the stories to the server now, click the No
button and go to task 6.

2 Remove the installation disk (or level disk) by dragging the RNInstall icon the
the trash.

3 Insert the CD for the level you want to copy in the CD-ROM drive of a client
workstation.  Then click the Continue button.

4 Click the Yes button to continue.

Installing the Macintosh Network Version, continued

Note: You should only run the stories from the server if your server has the
appropriate drive space available and you have a relatively fast network.
Otherwise, you should run the stories from the individual CDs at the
workstations.  Once you copy the stories to the server, students cannot use
the CDs to run the stories unless you reinstall the program.

Result: A message displays, verifying the level you are copying (from the CD) and
the location to which the level will be copied (the READ NATURALLY
program folder on the server).



4 If you want to copy another level, click the Yes button and go to step 2.  If you
do not want to add another level, go to step 5.

5 Click the No button when the copy process completes.

Task 6: Installing READ NATURALLY SE at Workstations
You must run the workstation installation program at each workstation where
teachers or students will use the READ NATURALLY applications.  To complete the
workstation installation, you need access to the folder you created on the server
when setting up access privileges (task 1).
1 Logon to the network from the client workstation as a user who can access the

RN Server folder on the server.
2 Double-click the InstallWkstnMac program in the RN Server folder on the

server.
3 Read the information on the Welcome window, and

then click the Continue button.
4 Read the information on the READ NATURALLY

Software Edition License Agreement window, and
then click the Agree button.

5 Verify that READ NATURALLY SE Workstation is
highlighted, and click the Install button.

Result: The program copies the stories to the server.  A status bar shows the copy
progress, and a message indicating that the level was added successfully
displays when the process completes.  The copy process for a single level
takes approximately five to ten minutes (depending on the type of server
and the drive space available).

Installing the Macintosh Network Version, continued
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Installing the Macintosh Network Version, continued

6 Indicate the location where you want to
install the READ NATURALLY SE
applications, and then click the Choose
button to begin the installation process. The
default location is the computer's hard drive
(e.g., if the hard drive name is "Macintosh
HD, " the default is "Macintosh HD").  You
can accept the default location by clicking
the Choose button or you can select a
different location.  You do not need to
create a folder.  The installation program 
automatically creates a folder called READ
NATURALLY.

Result: The installation program copies the READ NATURALLY files to the location
you specified on the workstation's hard drive.  A status bar shows the
installation progress, and a message displays when the process completes.
The installation program creates a "Student Stories" alias for the desktop
and a READ NATURALLY program folder.



Task 7: Setting Each Workstation's Path

In order to transfer the READ NATURALLY data collected at each workstation to one
central location on the server, you must set up a path at each workstation that points
to the RN Server folder on the server.  To set each workstation's path, follow these
steps:

1 Click the Next button.

2 Select the RN Server folder on the 
server, and then click the Choose button.

Installing the Macintosh Network Version, continued
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3) After you select the
RN Server folder, click

this button.

2) Highlight the 
RN Server folder (do

not open it).

1) Select the shared folder
you created on the server.

Result: The navigation window opens to allow
you to browse to the location on the
server where you have saved your READ
NATURALLY files.
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Task 8: Getting Started in the Teacher Management System

After you complete the READ NATURALLY SE installation, you have the option of
immediately getting started in the program.  A message displays letting you know
that you must enter teacher, class, and student information in the Teacher
Management System before students can begin using the READ NATURALLY program.
If you want to open the Teacher Management System immediately, click the Yes
button.  The blue Teacher Management System will open.  Then follow the
directions on page 25 of the User Guide to get started in the Teacher Management
System.
If you do not want to open the Teacher Management System now, click the No
button.  You can open the Teacher Management System later by following the
directions on page 24 of the User Guide.
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Uninstalling the Macintosh Network Version

To remove the READ NATURALLY SE applications from your system, you need to
complete the following tasks:

Run the Uninstallation Program at Each Workstation

Delete the READ NATURALLY Folder From the Server

Task 1: Run the Uninstallation Program at Each Workstation

1 Insert the installation CD into the computer's CD-ROM drive.

2 If the CD window does not open automatically, double-click the CD icon on the
desktop to open the CD.

3 Double-click the Uninstall Read Naturally SE
icon.

4 Select the Uninstall option from the drop-down
menu, and then click the Uninstall button.

Task 2: Delete the READ NATURALLY Folder From the Server
To delete the READ NATURALLY folder from the server, complete the following steps:

1 Locate the RN Server folder on the server, and then select it.
2 Drag the folder to the trash to delete it.

Result: The uninstall program removes all of
the READ NATURALLY SE files from
your hard drive.



In order to view READ NATURALLY SE's reports, awards, and online help, the
computer must have Internet Explorer 5.0 or higher installed.  If your computer does
not already have Internet Explorer, you can install the version included on the CD,
or you can download the latest version from Microsoft by visiting
www.microsoft.com/windows/ie.

To install Internet Explorer for Windows from the installation CD, follow the steps
below:

1 Insert the installation CD in the computer's CD-ROM drive.

2 If the installation program begins automatically, click the Exit button and then
the Yes button to confirm you want to Exit the READ NATURALLY installation.

3 Go to the CD drive, and open (double-click) the Setup folder.

4 Open (double-click) the READ NATURALLY folder.

5 Open (double-click) the Ie5setup folder.

6 Double-click the Ie5setup.exe installation program.

7 Follow the on-screen installation instructions.

Chapter  6—Windows  IE  Installation

Result: The Internet Explorer installation wizard opens.

Note: To uninstall Internet Explorer, use the Add/Remove programs function
available through the Control Panel of your Windows computer.
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In order to view READ NATURALLY SE's reports, awards, and online help, the
computer must have Internet Explorer 5.0 or higher installed.  If your computer does
not already have Internet Explorer, you can install the version included on the CD,
or you can download the latest version from Microsoft by visiting
www.microsoft.com/mac/products/ie.

To install Internet Explorer for Macintosh from the installation CD, follow the steps
below:

1 Insert the installation CD in the computer's CD-ROM drive.

2 If it does not open automatically, double click the CD icon on the desktop to 
open the CD.

3 Double-click the IE5 folder.

4 Drag the Microsoft Internet 5 folder to your desktop (or other location).

Chapter  7—Macintosh  IE  Installation

Note: To uninstall Internet Explorer, drag the Microsoft Internet 5 folder to the
trash to delete it from your Macintosh computer.
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Chapter  8—Troubleshooting
This chapter provides troubleshooting information to help you solve problems you
may have when installing READ NATURALLY SE.

Installation Issues
The table below provides solutions to common installation issues.

Problem Solution

I can't install READ
NATURALLY SE after hav-
ing the trial basis version.

Go into the System folder (on a Mac) or the Windows
folder (on a PC) and delete the file called
"12574.v12."  You will not need to uninstall the trial
version.  Just put the install disc in the computer and
enter the new license numbers.

How do I reinstall the SE
programs?  When I insert
the Install disc, it says it
will add levels without
reinstalling all the files.

To reinstall the SE program, follow these steps:

1 For Windows, navigate to C:\Windows.  For
Macintosh, navigate to Mac HD\System Folder.

2 Delete the "RNInst0602" file.
3 Run the installation program to reinstall the files.

I want to set up my
network version to work
with both Mac and
Windows clients.  Is that
possible?

Yes, the SE network version can be installed to use
cross-platform.  Make sure you have separate codes
for both the Mac and the Windows installation.
(Contact READ NATURALLY if you are missing a code.)
Then follow these steps:

1 Install the Windows network version on the server.
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Problem Solution

(See the previous page.) Note: If you want to copy the stories to the server,
you will need to copy them during both the
Windows and Macintosh network
installations.  These installations will copy the
files to a READNATURALLYCD and a
READNATCD folder respectively.  You will
need 500 MB of server space per level.

2 Install the Macintosh network version on the
server, using the RN Server folder that was created
by the Windows installation as the location for the
Macintosh installation.

Result: The installation program will add the files
required to run the Macintosh version to the
folder.

3 Run the Windows client installation from each
Windows workstation by navigating to the RN
Server folder on the server, double-clicking on the
InstallWkstnWin icon, and following the on-screen
instructions. (You can also see page 25 in the
Installation Guide)

4 Run the Macintosh client installation from each
Macintosh workstation by navigating to the RN
Server folder on the server, double-clicking on the
InstallWkstnMac icon, and following the on-
screen instructions.  (You can also see page 36 in
the Installation Guide.)

Installation Issues, continued
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